
ZMMiK Laboratorium 2 - analiza kontaktu

1 Cel laboratorium
Celem ćwiczenia laboratoryjnego jest przeprowadzenie analizy numerycznej sprężystego kontaktu po-
między kulą, a płaską powierzchnią. Schemat geometrii i obciążeń przedstawiony jest na Rysunku ??.
Rozwiązanie numeryczne tego zagadnienia stanowi punkt odniesienia do weryfikacji zgodności wyników
symulacji z analityczną teorią kontaktu Hertza, w szczególności w zakresie rozkładu ciśnienia i rozmiaru
obszaru styku. Analizie poddane zostaną dwa modele - osiowosymetryczny oraz trójwymiarowy.

• L = 20mm, R = 10mm,
• E = 2 · 105 MPa, ν = 0.3,
• P = 1000N.

Rysunek 1: Schemat modelowanej geometrii.
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2 Przygotowanie geometrii
1. Zaczynamy od samego modułu Geometry - Rysunek 2: 1. Następnie New SpaceClaim Geometry - 2.

Rysunek 2: Przygotowanie geometrii.

2. W nowym szkicowniku (płaszczyzna XY ) zaczynamy od narysowania kwadratu o boku 20 mm, tak
aby lewy wierzchołek znajdował się w środku układu współrzędnych - Rysunek 3.

Rysunek 3: Geometria płyty.
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3. Natępnym krokiem jest narysowanie półokręgu:
• Przy pomocy funkcji Sweep Arc zaczynamy od wskazania środka okręgu w punkcie (0, 10) i

zaznaczenia promienia okręgu - Rysunek 4: 1.
• Kreślimy półokrąg zaczynając od górnego punktu - Rysunek 4: 2.

Rysunek 4: Geometria kuli.

3



4. Ostatnim krokiem w szkicowniku jest domknięcie półokręgu funkcją Line - Rysunek 5.

Rysunek 5: Domknięcie szkicu.

5. Po wyjściu ze szkicu (Return to 3D mode) ostatnią czynnością jest podzielenie powierzchni na dwa
ciała: PPM na Surface → Detach All - Rysunek 6: 1. W efekcie powinny powstać dwie oddzielne
powierzchnie - Rysunek 6: 2.

Rysunek 6: Podzielenie geometrii.
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6. Po ukończeniu szkicu można wyjść z programu SpaceClaim. W celu ułatwienia sobie pracy przy
modelu trójwymiarowym duplikujemy moduł geometry - Rysunek 7: 1, przy okazji można zmie-
nić nazwy modułów: 2. Następnie należy dodać moduły Static Structural i połączyć przygotowaną
geometrię z odpowiednim polem: 3.

Rysunek 7: Schemat projektu z przygotowaną geometrią.

3 Model osiowosymetryczny
1. Przed przejściem do Ansys Mechanical należy we właściwościach zadania dwuwymiarowego zazna-

czyć Analysis Type jako 2D - Rysunek 8.

Rysunek 8: Zmiana ustawień na analizę 2D.
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2. Po otwarciu Ansys Mechanical w zakładce Geometry powinny widnieć dwie powierzchnie (jest to
istotne z punktu widzenia kontaktu) - Rysunek 9: 1. Dodatkowo należy w opcjach zakładki ustawić
typ zadania na osiowosymetryczne: 2.

Rysunek 9: Ustawienia typu zadania na osiowosymetryczne.

3. Zadanie kontaktu między krawędziami - Rysunek 10:
• 1 - Program powinien sam wykryć i dodać w zakładce Connections grupę kontaktową. Jeżeli

tak się nie stało: PPM na Connections→ Create Automatic Connections.
• 2 - Jako Contact wskazać krawędź kuli, jako Target wskazać krawędź płyty.
• 3 - Ustawiamy kontakt bez tarcia - Frictionless.
• 4 - Metoda kontaktu: Normal Lagrange.

Rysunek 10: Ustawienia typu zadania na osiowosymetryczne.
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4. Przygotowanie siatki elementów skończonych (PPM na Mesh→ Insert→ . . . ):
• Rysunek 11 - Metoda siatki Method: 1. Ustawienia metody: 2.

Rysunek 11: Metoda siatki.

• Rysunek 12 - Nadanie podziału na średnicy półokręgu Sizing. Uwaga: chcemy, aby zagęszczenie
linii odbywało się w stronę punktu kontaktu, jeżeli program pokazuje zagęszczenie w drugim
kierunku należy to zmienić zaznaczając odpowiednią linię w Reverse Bias.

Rysunek 12: Zadanie podziału na średnicy półokręgu.

7



• Rysunek 13 - Nadanie podziału na płytę.

Rysunek 13: Zadanie podziału na krawędziach płyty.

• Rysunek 14 - Nadanie podziału na obwodzie półokręgu.

Rysunek 14: Zadanie podziału na obwodzie półokręgu.
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• Wynikowa siatka powinna prezentować się następująco:

Rysunek 15: Gotowa siatka.

5. Nadanie warunków brzegowych Rysunek 16 (PPM na Static Structural→ Insert→ . . . ):
• A - Displacement na dwóch krawędziach znajdujących się na osi symetrii: X:0, Y :Free.
• B - Fixed Support na dolnej krawędzi.
• C - Remote Force na obwodzie półokręgu - Rysunek 17.

Rysunek 16: Warunki brzegowe.
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Rysunek 17: Ustawienia Remote Force.

6. Ustawienia analizy nieliniowej - Rysunek 18:

Rysunek 18: Ustawienia analizy.
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7. Prezentacja wyników:
• Naprężenia zredukowane w strefie kontaktu:

Rysunek 19: Naprężenia zredukowane w strefie kontaktu.

• Naprężenia na kierunku X w strefie kontaktu:

Rysunek 20: Naprężenia na kierunku X w strefie kontaktu.
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8. Dodanie narzędzia do wyświetlania wyników w elementach kontaktowych - PPM na Solution →
Insert→ Contact Tool→ Contact Tool - Rysunek 22: 1. Należy dodać (PPM na Contact Tool→ Insert
→ . . . ) dwa typy rozwiązań: Status oraz Pressure 2.

Rysunek 21: Dodanie narzędzia kontaktu.

• Status kontaktu:

Rysunek 22: Status kontaktu.
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• Nacisk w strefie kontaktu:

Rysunek 23: Nacisk w strefie kontaktu.

9. Przygotowanie ścieżek do przedstawienia wyników:
• Dodanie geometrii konstrukcyjnej - Rysunek 24.

Rysunek 24: Dodanie geometrii konstrukcyjnej.
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• Rysunek 25: 1 - Dodanie ścieżki.
• Rysunek 25: 2 - Zdefiniowanie ścieżki poprzez krawędź.
• Rysunek 25: 3 - chcemy, żeby ścieżki miały początek w punkcie (0, 0) (czyli w miejscu styku

półokręgu z kwadratem), jeżeli z programu wynika, że ten kierunek jest odwrócony to należy
użyć Flip Path Orientation.

Rysunek 25: Sposób przygotowania ścieżek.
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• W tym zadaniu należy przygotować dwie ścieżki - jedną na kierunku x i jedną na kierunku y
zaczynające się w punkcie kontaktu, tak jak na Rysunek 26.

Rysunek 26: Przygotowanie dwóch ścieżek.

10. Aby zaprezentować wyniki na ścieżce należy po dodaniu rozwiązania (Solution → Insert → . . . ).
Następnie w Scoping Method wybrać Path i zaznaczyć ścieżkę po nazwie - Rysunek 27.

Rysunek 27: Opcje wyświetlania na ścieżkach.
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Rysunek 28: Naprężenie na kierunku X na ścieżce x.

11. Przygotowanie wykresu kilku składowych na kierunku Y (Chart) - Rysunek 29 :
• W pierwszym kroku należy przygotować rozwiązania naprężeń zredukowanych SEQV, naprę-

żeń na kierunku X SX, naprężeń na kierunku Y SY oraz naprężeń stycznych SXY. Robimy to
tak samo jak w poprzednim zadaniu z tą różnicą, że tym razem wyniki prezentowane są na
ścieżce y. Uwaga: nazwy rozwiązań można zmieniać przy pomocy klawisza F2.

• Po dodaniu Chart w Outline Selection zaznaczamy wspomniane rozwiązania.

Rysunek 29: Przygotowanie wykresu.

16



• Fragment wykresu można przybliżyć. Należy najpierw zaznaczyć interesujący zakres i następ-
nie PPM→ Zoom To Range - Rysunek 30:

Rysunek 30: Wykres na ścieżce y.

• Wykres po przybliżeniu:

Rysunek 31: Wykres na ścieżce y - widok w pobliżu strefy kontaktu.
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4 Model trójwymiarowy
1. Wracamy do geometrii przygotowanej na początku instrukcji - Moduł C→ Edit Geometry in SpaceC-

laim.
• Obrócenie geometrii - Rysunek 32

Rysunek 32: Edycja geometrii.

• 1 - Wybranie opcji Pull.
• 2 - Zaznaczenie obu powierzchni.
• 3 - Uwaga: Opcja No merge musi być zaznaczona.
• 4 - Wybranie opcji obrotu wokół osi.
• 5 - Zaznaczenie osi Y jako osi obrotu.
• 6 - Aby obrócić model o zadaną wartość wpisujemy 90 i zatwierdzamy klawiszem Enter.
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• Model po obrocie:

Rysunek 33: Geometria modelu 3D.

2. Zadanie parametrów kontaktu - Rysunek 34: 1 . Zasada jest taka sama jak w zadaniu 2D. Jedyna
różnica to model kontaktu - ustawiamy Augmented Lagrange: 2.

Rysunek 34: Parametry kontaktu - zadanie 3D.
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3. Zadanie symetrii Rysunek 35
• 1 - Dodanie zakładki związanej z symetrią Insert→ Symmetry.
• 2 - Wprowadzenie typu symetrii jako obszaru Insert→ Symmetry Region. Będą potrzebne dwa

takie obszary.
• 3 - Pierwszy obszar związany jest z osią Z. Najpierw należy zaznaczyć dwie powierzchnie, a

następnie odpowiednią oś normalną do tych powierzchni.
• 4 - Ta sama czynność jak w poprzednim punkcie, ale dla powierzchni z normalną na Y .

Rysunek 35: Wprowadzenie symetrii.
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4. Przygotowanie siatki - nadanie parametrów globalnych - Rysunek 36:
• 1 - Globalne ustawienia siatki - elementy drugiego rzędu.
• 2 - Metoda: Hex Dominant.
• 3 - Sizing: 1 mm dla obu ciał.

Rysunek 36: Wprowadzenie globalnych parametrów siatki.
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5. Przygotowanie siatki - lokalne zagęszczenie w strefie kontaktu - Rysunek 37:
• 1 - Należy wprowadzić dwa elementy Sizing, które zostaną przypisane do wierzchołków - jeden

związany z kulą oraz jeden związany z płytą.
• 2 - W każdym z nich należy w Geometry zaznaczyć wierzchołki.
• 3 - Uwaga: oba wierzchołki zajmują to samo miejsce w przestrzeni. Żeby zaznaczyć konkretny

wierzchołek należy zaznaczyć na płaszczyźnie w rogu ekranu odpowiedni element. Kolor płasz-
czyzny odpowiada kolorowi ciała.

• 4 - parametry elementów w strefie zagęszczenia.

Rysunek 37: Wprowadzenie zagęszczenia w strefie kontaktu.

• Siatka elementów skończonych powinna ostatecznie wyglądać następująco:

Rysunek 38: Wynikowa siatka.
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6. Warunki brzegowe w zadaniu - Rysunek 39:
• A - Fixed Support na dolnej powierzchni płyty.
• B - Remote Force na fragmencie sfery. Parametry siły 1, uwaga: tym razem przykładamy 250 N.

Rysunek 39: Warunki brzegowe w zadaniu 3D.
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7. Ustawienia analizy nieliniowej - Rysunek 40:

Rysunek 40: Ustawienia analizy 3D.

8. Prezentacja wyników:
• Naprężenia zredukowane w strefie kontaktu:

Rysunek 41: Naprężenia zredukowane w strefie kontaktu - zadanie 3D.
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• Naprężenia na kierunku X w strefie kontaktu:

Rysunek 42: Naprężenia na kierunku X w strefie kontaktu - zadanie 3D.

• Contact Tool - nacisk w strefie kontaktu:

Rysunek 43: Nacisk w strefie kontaktu - zadanie 3D.
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9. Wprowadzenie ścieżek w zadaniu - Rysunek 44: 2 - podobnie jak w zadaniu poprzednim kierunki
ścieżek należy ustawić tak, aby zaczynały się one w strefie kontaktu.

Rysunek 44: Ścieżki x i y w zadaniu 3D.

• Wykres naprężeń na kierunku Y na ścieżce x:

Rysunek 45: Naprężenie na kierunku X na ścieżce x.
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• Wykres SEQV, SX, SY oraz SXY na ścieżce y. 1 - cały wykres oraz 2 - przybliżony fragment.

Rysunek 46: Wykresy na ścieżce y.

5 Zadania do wykonania

5.1 Obliczenia analityczne
Wprzypadku mechaniki kontaktu pomiędzy dwoma ciałami (1 i 2) głównymi wielkościami teoretycznymi,
do których możemy odnieść wartości numeryczne to maksymalne ciśnienie styku p0 promień kontaktu a
oraz całkowite wgniecenie δ.

W pierwszym kroku należy policzyć moduł za-
stępczy E∗:

1

E∗ =
1− ν21
E1

+
1− ν22
E2

(1)

oraz promień zastępczy R∗:

a =
3

√
3PR

4E∗ . (2)

Z tego mamy rozkład ciśnienia styku p(r):

p(r) = p0

√
1−

( r
a

)2
dla 0 ≤ r ≤ a, (3)

który osiąga maksimum p0 równe:

p0 =
3P

2πa2
. (4)

Całkowite wgniecenie:

δ = 3

√
9P 2

16R(E∗)2
. (5)

W naszym przypadku promień płyty
R2 =∞ ⇒ R∗ = R1 = R. Rysunek 47: Teoretyczny schemat zadania.
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5.2 Zadania
1. Przperowadzić analizę kontaktu odkształcalnej płyty z nieodkształcalną kulą: E1 = ∞, E2 = E,

ν2 = ν. W tym celu w ustawieniach Remote Force w zakładce Behavior zmienić z Deformable na
Rigid. Rysunki 17 i 39.

2. Sprawdzić wpływ gęstości siatki na dokładność wyników.
3. Sprawdzić wpływ metody kontaktu na dokładność wyników. Rysunki 10 i 34.
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